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When to Submit Rosters to DECAL 

E-mail Notification 

Bright from the Start: Georgia Department of Early Care and Learning (DECAL) will send an e-mail 

notification when rosters are open for student data entry. The e-mail will provide the roster count date and 

due date. Providers may begin entering student data when the roster opens but cannot submit the roster 

until the count date. 

 

Teacher data updates may be made at any time. For questions regarding teacher data entry, refer to the 

PANDA Teacher Data Training Document located on the PANDA Resources webpage at 

https://www.decal.ga.gov/Prek/PANDAResources.aspx  

 

PANDA Critical Reporting Dates  

There are several ways to view the roster count and due dates. 

1. The roster dates are included in the PANDA Critical Reporting Dates document providers read and 

acknowledged during the application process. To view the Panda Critical Dates document, complete 

the following steps: 

a. In the left-side navigation menu, select Pre-K. 

b. Click Enter Application. 

 

 

 

 

 
 

 

 

 

 
 

The application opens on the Read Me Files tab. 

c. Click the PANDA Critical Reporting Dates link in the Pre-K Application Mandatory 

Documents section.   

 

https://www.decal.ga.gov/Prek/PANDAResources.aspx
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2. The calendar on the PANDA dashboard is preloaded with important Pre-K information, such as the 

roster count and due dates. 

a. In the lower right corner of the dashboard, hover the mouse over a highlighted day to display 

the details for that date.  

 

b. To check future or past dates, click the left arrow (>) to scroll forward a month and the right 

arrow (<) to scroll back a month.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 Student Data Training Document 

Bright from the Start : Georgia Department of Early Care and Learning Page 5 of 57 

Reporting Students on the Roster 

• Report students who have met all Georgia’s Pre-K eligibility requirements and have physically 

attended the program at least 1 day.  

• Children whose parents have submitted enrollment paperwork but have not attended a scheduled 

Pre-K instructional day should not be reported on the roster. 

• Students who have physically attended the program but are absent on the count date should be 

reported on the roster. 

• Student who withdrew from the class on or before the count date, the end date should be entered 

for the student. Any change occurring after the Count Date should be reported on the next roster 

due in November.   

Entering Student Information 

There are two ways to enter students on Roster 1: 

Method 1: Manual data entry online via the Add Student screen. Instructions begin on page 6.   

 

Method 2: Upload student information in bulk via the PANDA Student Roster Template. 

Instructions begin on page 12. The upload function is only available for Roster 1. Students 

who arrive after the upload has completed should be added manually into PANDA. 

  

All public schools that are using Infinite Campus, PowerSchool, or Aspen should use 

the upload method to enter students on Roster 1. 

Entering Students Manually 

1. Launch PANDA and log in with your credentials.  

• For information about PANDA login accounts, refer to the PANDA Provider User 

Management document found on the PANDA Resources page located at 

http://decal.ga.gov/Prek/PANDAResources.aspx.   

 

2. In the left-side navigation menu, select (a) Pre-K, click on (b) Rosters, and then click on 

(c)View/Edit Roster.  

 

http://www.decal.ga.gov/panda
http://www.decal.ga.gov/documents/attachments/ProviderUserMgmt.pdf
http://www.decal.ga.gov/documents/attachments/ProviderUserMgmt.pdf
http://decal.ga.gov/Prek/PANDAResources.aspx


 Student Data Training Document 

Bright from the Start : Georgia Department of Early Care and Learning Page 6 of 57 

  
 

The Roster Provider Site List page opens. The Site Name column displays each Site Name as a 

hyperlink. 

 

3. To choose a site, click the Site Name.  

 
 

The Roster Class List displays. The Class ID column displays each Class ID as a hyperlink. 

 

4. To choose a class, click on the desired Class ID.  

 
 

5. On the roster details screen, scroll down to the Student Information section and click the Add button.  
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6. The Student Information screen displays as shown below.  

 
7. Complete the following fields for each student who has physically attended for at least 1 day. 

NOTE: If the site offered a Rising Pre-K Summer Transition Pre-K (STP) class, the button 

will display (only during Roster 1) allowing you to select a student from your STP roster. The student’s 

data will automatically populate for you.  Review/update any fields that need to be corrected and 

populate all remaining fields. 

 

Field Action Required 

 Student Last 

Name  

Enter the student’s Last Name exactly as it appears on the student’s age 

documentation.  The student’s last name must have two or more letters and may 

include hyphens, apostrophes, and periods. Do not include a suffix as part of the 

last name.  

 Student First 

Name  

Enter the student’s First Name exactly as it appears on the student’s age 

documentation.  The first name must have at least two letters and can include two 

names separated by hyphens, apostrophes, spaces, or periods (e.g., Jean-Paul, 

Da’Shandra, or T.J.). 

 Student Middle 

Name  

Enter the student’s full middle name exactly as it appears on the student’s age 

documentation. Hyphens, apostrophes, and periods may be included.  If the 

student does not have a Middle Name, enter NMN to represent No Middle Name. 

This indicates you have verified there is not a middle name listed on the student’s 

age documentation.  

 Suffix If applicable, select either Jr, II, III, IV, etc. from the drop-down. 

 Date of Birth  Enter the student's birthday exactly as it appears on the student’s age 

documentation using the format “MM/DD/YYYY”. 
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Field Action Required 

 SSN  Enter the student's Social Security number (SSN) exactly as it appears on a copy 

of the student’s Social Security Card. Providers should not enter the Social 

Security number reported on enrollment documents. Social Security numbers are 

encrypted in the system to ensure data security.  

• Verify that each student’s SSN was entered correctly. 

• If a parent chooses not to submit the Social Security card, providers 

should ask the parent to complete the Student Social Security Number 

Information Form (Appendix B). 
 

Note (1):  If the SSN is omitted, after clicking Save, an error message displays. Using information from the Student 

Social Security Number Information Form, select the appropriate box in the SSN Waiver Reason section. 

 

 

Note (2):  Providers should follow up in a timely manner with parents who selected any of the first four 

reasons to track their progress in obtaining a Social Security number for their child. 
 

Note (3):  To add an SSN after the student information has been saved, return to the Roster Detail screen 

and click on the POPULATE SSN link next to the desired student’s name. Then enter the SSN and click 

Save. It is not necessary to close/re-enter the student in order to populate the SSN. 
 

 

 

CORRECTING NAME, DATE OF BIRTH, AND SSN AFTER STUDENT RECORD HAS 

BEEN SAVED 

Providers cannot change the name, date of birth, or Social Security number once the entry is saved. 

If incorrect data was entered, DO NOT delete the student and reenter the student to correct the data 

entry error. This will assign a second student ID number to a child with an existing number and flag 

the student as a duplicate. To request a correction to name, date of birth or Social Security number, 

submit the Pre-K Roster Correction Request Form located under the Project Director Resource List 

at http://www.decal.ga.gov/PreK/ProjectDirectors.aspx   

 

 

(a) In the Waiver Reason section, select the appropriate checkbox as 

specified by the parent on the Student Social Security Number 

Information Form. 

(b) If the parent selected ‘I do not choose to 

provide the SSN because …’, enter the 

reason in the Waiver Reason Detail field 

exactly as the parent entered it on the 

Waiver Form. 

 

Important 

http://www.decal.ga.gov/PreK/ProjectDirectors.aspx
http://www.decal.ga.gov/PreK/ProjectDirectors.aspx
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Field Action Required 

 Gender  Select the student’s gender:   

 Male  Female 
 

 Multiple Birth  From the Multiple Birth drop-down list, select whether the student is from a single 

birth, twins, or a higher-order multiples (triplets or more) birth. For example, if 

John and Sally are twins, “2” should be selected for each of them. 

Select Description  

1 If the child was born from a single birth 

2 If the child was born from a twin birth 

3 If the child was born from a triplet birth 

4 If the child was born from a quadruplet birth 

5 If the child was born from a quintuplet birth 

0 

 Transportation  Select the student’s Transportation indicator from the drop-down list. If the Center 

transports the child to and from Pre-K, select Yes.   

 Yes  No 
 

 Socio/Economic  Select the appropriate Socio-Economic indicator from the drop-down.  

 Category 1    Select this option if the child and/or child’s family participates 

in one of the following: Supplemental Nutrition Assistance program 

(SNAP), SSI (Supplemental Security Income), Medicaid, Temporary 

Assistance to Needy Families (TANF), or Child and Parent Services 

(CAPS) program. Documentation of participation must be verified and kept 

on file. Children who participate in the free and reduced meal program 

through the school that they attend may also be eligible as Category One if 

income eligibility is verified and kept on file. 

 Category 2    Select this option if the child does not meet the requirements 

for Category 1 eligibility. 

 

 

CORRECTING TRANSPORTATION AND SOCIO/ECONOMIC 

To edit these fields, click on the student’s name to display the Student Information screen. Click on the 

Chg Trans/Socio button. Enter the correct values and the system will prompt you for an effective date for 

each field changed. DO NOT close and re-enter the student. 
 

Field Action Required 

 DLL Select the appropriate option for the DLL (Dual Language Learner) indicator from 

the drop-down list: 

Select Description 

Yes If the student speaks multiple languages 

No If the student speaks only one language 

o 

 IEP Select the appropriate option for the IEP (Individual Education Plan) from the 

drop-down list: 

Select Description 

Yes If an IEP is in place for the student 

No If the student does not have an IEP 

o 

Important 
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Field Action Required 

 Funding  Select the Class Funding Source from the drop-down list: 

Select Description 

Blended If the class receives both Head Start and Pre-K funding 

Lottery If the class only receives Pre-K funding 

o 

 Ethnicity  Select the student's ethnicity from the drop-down list:  

 Hispanic/Latino  Not Hispanic/Latino  Information not provided 
 

 Race  From the Race choices displayed, select all values that apply to this student:   

 American Indian/Alaskan Native 

 Asian 

 Black or African American 

 Native Hawaiian/Other Pacific Islander 

 White 

 Information not provided 
o 

 

 

CORRECTING GENDER, MULTIPLE BIRTHS, AND IEP  

To change Gender, Multiple Birth, or IEP, click on the hyperlinked value. The field menu opens. 

 

Select the correct value and click  to save the change.  

 

Field Action Required 

 Parent/Guardian 

Last Name 

Enter the last name of the student’s parent or guardian (mother preferred if 

available). 

 Parent/Guardian 

First Name 

Enter the first name of the student’s parent or guardian (mother preferred if 

available). 

 Relationship From the drop-down list, select the appropriate relationship of the parent or 

guardian to the student:  

 Mother  Father   Grandparent  Guardian 
o 

 Begin Date in 

Class  

Enter the first day the student is present in the class using the format 

“MM/DD/YYYY”.  

• The Begin Date cannot be on or prior to the count date of the previous 

roster.  

Important 
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Field Action Required 

• For Roster 1, the Begin Date cannot be prior to August 1st. 

• The Begin Date cannot be after the count date of the current roster. 

 End Date in Class  If applicable, enter the student's last day in the class using the format 

“MM/DD/YYYY”.   

• This date should only be entered if the student has un-enrolled from the 

class.   

• The End Date cannot be after the count date of the current roster. 

• The End Date cannot be a future date. 

 

8. Click .   

9. Click the  button to return to the Roster Class List or click  to enter another student onto the 

roster. 

 

 

 

 

 

If you entered students via the online process, proceed to Submitting Your Completed Roster to DECAL 

(page 39) for instructions on how to submit your roster. 
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Entering Students via the Upload Process 

Typically, the upload process is used by Providers with multiple sites/classes, but it can also be a time-

saver for those who have only one site/class. Using the upload process has a key advantage because the 

files can be created outside of PANDA prior to the date Roster Cycle 1 opens for entry. DECAL 

recommends that (1) a separate file be created for each site within your program and (2) the separate file 

should include all students for all classes at that site. If you have a large number of classes at one site, 

consider creating a separate file for each class.  

 

The upload process is only applicable to the first roster cycle of the school year. If a new student 

arrives after you have successfully completed the upload and on/before the count date, add the student 

manually using the online process described earlier in this document. It is not necessary to rerun the entire 

upload process again to add additional students. 

 

 

All Public schools using Infinite Campus, PowerSchool, or ASPEN are expected to obtain and 

upload the pre-populated files available to them. Public schools should NOT use the DECAL 

template.  These pre-populated files should be obtained prior to the Roster 1 Count Date.  If any 

students have left or were a no-show, be sure to close the student in Infinite Campus, PowerSchool or 

ASPEN before generating the student upload file. 

 

 

The upload process consists of two steps: 

1. Create student upload file(s) for each Site by using one of the following templates: 

• DECAL template from the agency’s website 

(http://www.decal.ga.gov/documents/attachments/Student_Roster_Template.xls)  

• Pre-populated template from Infinite Campus  

• Pre-populated template from PowerSchool    

• Pre-populated template from ASPEN 

• Pre-populated template from ChildPlus 

 

2. Upload the completed student roster file(s) and resolve any errors. 

 

 

Regardless of which upload template is used, you will need to verify your Site ID and Class ID values 

each year because the Class ID values change each school year.  This can easily be done by pulling the 

Provider Site-Class List Report using the steps listed below: 

 

1. After selecting the View/Edit Roster menu option, click on the Reports button and select the 

Provider Site-Class List option from the dropdown menu. 

       

Important 

2023 

http://www.decal.ga.gov/documents/attachments/Student_Roster_Template.xls
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2. The report will open in a separate browser window where you can choose to ‘print’ the report or 

you can ‘save’ the report to a pdf file.   

 

 

Separate instructions are given below based on whether you are manually populating the DECAL template 

or whether you are using a pre-populated template from your data vendor. The instructions are different for 

each method, so be sure to follow the section below that is appropriate for your specific program.     

 

• If using the DECAL template, please proceed to page 14. 

• If your school system uses Infinite Campus, please proceed to page 20. 

• If your school system uses PowerSchool, please proceed to page 23. 

• If your school system uses ASPEN, please proceed to page 27. 

• If your program uses ChildPlus, please proceed to page 31. 

 

The pre-populated templates are currently only applicable to public schools who use Infinite Campus, 

PowerSchool, or ASPEN as their data vendor, and to programs that use ChildPlus.   
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Creating an Upload File Using the DECAL Template 

1. On the Panda home page, scroll down to the Panda Resources section and click on Click here. 

 

2. Select the PANDA Student Roster Template option from the Document List.  

(a) Save the .xls file to a folder on your computer.   

(b) You will need to download the current template at the beginning of each school year. 

 

3. Double-click on the .xls file you just saved, which will launch Microsoft Excel.  

 

4. Follow the instructions shown in the header rows highlighted in red and begin entering your data on 

line 8 of the excel worksheet. 

 

 

If you are populating the template in advance of the school year with students chosen in the 

lottery, remember you must remove any students who were no-shows prior to uploading your file 

to PANDA. When uploaded, the file should only include students who were physically in 

attendance for 1 day or more.  

 

 
 

 

As you tab through each column, a popup will be displayed clarifying what each column represents.     

Where applicable, a dropdown has been added for a column if there is a restricted list of valid values 

allowed.  

 

The columns included in the template are listed below:   

Column – Field Action Required 

A – Site ID Enter the Site ID for the class you are uploading. 

(a) To verify your Site ID, go to Panda and click on Pre-K, Rosters, and then 

View/Edit Roster. 

(b) On the Provider Site List page displayed, scroll to your County/Site Name 

to locate the Site ID.  

 

Important 
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Column – Field Action Required 

B – Class # Enter the Class ID.  

(a) To determine your Class ID, click on your Site Name. 

(b) The Class List page displays the Class IDs for each class at that Site. 

 

C – Student Last 

name 

Enter the student’s Last Name exactly as it appears on the student’s age 

documentation.  The student’s last name must have two or more letters and may 

include hyphens, apostrophes, and periods.  Do not include a suffix as part of the last 

name (e.g., D’Angelo, Smith-Kline, or St. Claire).  

D – Student First 

name 

Enter the student’s First Name exactly as it appears on the student’s age 

documentation.  The student’s first name must have at least two letters.  The first 

name can include two names separated by hyphens, apostrophes, spaces, or periods 

(e.g., Jean-Paul, Da’Shandra, or T.J.). 

E – Student SSN Enter the student’s SSN (Social Security Number) using the format “123456789” 

without dashes. It will be encrypted in the system to ensure data security.  

• If the SSN has a leading zero, you will need to precede the value 

entered with an apostrophe (i.e., ‘012345678). Otherwise, Excel will 

drop the leading zero(es) and the record will be flagged as an error in 

the upload for being less than 9 digits. 

• Please verify that each student’s SSN was entered correctly. 

• If a parent chooses not to submit the Social Security card, providers should 

ask the parent to complete the Student Social Security Number Information 

Form (Appendix B). 

Note:  If you are a public school district and have already assigned a ‘999’ pseudo-

social, leave this field blank and be sure to populate the waiver information into 

Columns S and T. 

F – Student Gender Select the student’s gender from the dropdown:   

 M = Male  F = Female 
 

G – Student DOB Enter the student’s Date of Birth exactly as it appears on the student’s age 

documentation using the format “MM/DD/YYYY”. 

Conyers County School District  

03 

DeKalb 

Emily Dickinson 



 Student Data Training Document 

Bright from the Start : Georgia Department of Early Care and Learning Page 16 of 57 

Column – Field Action Required 

H – Birth Indicator From the Multiple Birth drop-down list, select whether the student is from a single 

birth, twins, or a higher-order multiples (triplets or more) birth. For example, if John 

and Sally are twins, both would have “2” selected for Multiple Birth. 

Select Description 

1 If the child was born from a single birth 

2 If the child was born from a twin birth 

3 If the child was born from a triplet birth 

4 If the child was born from a quadruplet birth 

5 If the child was born from a quintuplet birth 

O 

I – Socio/Economic Select the appropriate Socio-Economic indicator from the drop-down.  

 Category 1    Select this option if the child and/or child’s family participates in 

one of the following: Supplemental Nutrition Assistance program (SNAP), SSI 

(Supplemental Security Income), Medicaid, Temporary Assistance to Needy 

Families (TANF), or Child and Parent Services (CAPS) program. 

Documentation of participation must be verified and kept on file. Children who 

participate in the free and reduced meal program through the school that they 

attend may also be eligible as Category One if income eligibility is verified and 

kept on file. 

 Category 2    Select this option if the child does not meet the requirements for 

Category 1 eligibility. 

J – Transportation  Select the student’s Transportation indicator from the drop-down list. If the Center 

transports the child to and from Pre-K, select Yes.   

 Yes  No 
 

K – Ethnicity  Select the student's ethnicity from the drop-down:  

 Hispanic/Latino  Not Hispanic/Latino 
 

L – Dual Language 

Learner 

Indicator 

Select the appropriate option from the DLL (Dual Language Learner) indicator from 

the drop-down list: 

Select Description 

Yes If the student speaks multiple languages 

No If the student speaks only one language 

o 

M – IEP  Select the appropriate option for the IEP (Individual Education Plan) from the drop-

down list: 

Select Description 

Yes If an IEP is in place for the student 

No If the student does not have an IEP 

o 

N – Funding  Select the Class Funding Source from the drop-down list: 

Select Description 

Blended If the class receives both Head Start and Pre-K funding 

Lottery If the class only receives Pre-K funding 
 

O – Begin Date Enter the student’s first day in the Pre-K class using the format “MM/DD/YYYY”. 
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Column – Field Action Required 

• The Begin Date cannot be on or prior to the count date of the previous 

Roster.   

• For Roster 1, the Begin Date cannot be prior to August 1st. 

• The Begin Date cannot be after the Count Date of the current roster. 

P – End Date If applicable, enter the student's last day in the Pre-K class using the format 

“MM/DD/YYYY”.   

• This date should only be entered if the student has un-enrolled from the 

class.   

• The End Date cannot be after the count date of the current roster. 

• The End Date cannot be a future date. 

Q – Middle Name Enter the student’s full middle name exactly as it appears on the student’s age 

documentation.  Hyphens, apostrophes, and periods may be included.  If the student 

does not have a Middle Name, enter NMN to represent No Middle Name. This 

indicates you have verified there is not a middle name listed on the student’s age 

documentation. 

R – Name Suffix  If applicable, select the appropriate Jr, II, III, IV, etc. value from the drop-down list. 

S – Waiver Reason 

Code 

If the Student’s SSN was not provided, enter the Waiver Reason Code (e.g., 1, 2, 3 

…) that corresponds with the reason selected by the Parent on the Student Social 

Security Number Information Form. 

Select Description 

1 I need help in obtaining an SSN. 

2 I need help replacing a lost SSN. 

3 I am awaiting a replacement SSN and will provide when it arrives. 

4 I forgot to bring the SSN and will provide within 30 days. 

5 I choose not to provide the SSN because …. 

o 

T – Waiver Reason 

Detail 

If the Waiver Reason Code = 5, enter the Waiver Reason Detail which is the written 

reason provided by the Parent on the Student Social Security Number Information 

Form. 
 

Note:  Do not enter any commas into this field. 

U – American Indian 

or Alaskan 

Native 

Select the appropriate Yes/No indicator from the drop-down list to indicate whether 

the race of American Indian/Alaskan Native is applicable to this student. 

V – Asian  Select the appropriate Yes/No indicator from the drop-down list to indicate whether 

the race of Asian is applicable to this student. 

W – Black or African 

American 

Select the appropriate Yes/No indicator from the drop-down list to indicate whether 

the race of Black or African American is applicable to this student. 

X – Native Hawaiian 

or Other Pacific 

Islander 

Select the appropriate Yes/No indicator from the drop-down list to indicate whether 

the race of Native Hawaiian or Other Pacific Islander is applicable to this student. 

Y – White  Select the appropriate Yes/No indicator from the drop-down list to indicate whether 

the race of White is applicable to this student. 
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For each student entered, select Y for at least one of the race values located in columns U-Y. Should 

it be necessary, you may indicate Y for as many races as are applicable for the student. 

 

Column – Field Action Required 

Z – GTID  Leave Column Z blank. Do not manually enter the student’s 10 digit GTID. This 

field is only included in the template so that the file format will match the pre-

populated files generated by Infinite Campus, Pearson PowerSchool, or ASPEN.     

AA – Parent/ 

Guardian First Name 

Enter the first name of the student’s parent or guardian (mother preferred if 

available). 

AB – Parent/ 

Guardian Last Name 

Enter the last name of the student’s parent or guardian (mother preferred if available). 

AC – Relationship From the drop-down list, select the appropriate relationship of the parent or guardian 

to the student:  

 Mother  Father   Grandparent  Guardian 
o 

 

 

5. Repeat step 4 for each student until all students for the respective Site have been entered.   

Note:  You can edit your .xls file as many times as needed.  

 

6. Once your entry of the student data is complete/accurate, follow the instructions included at the top of 

the DECAL template to delete the red and yellow highlighted rows so that your first student becomes 

the first row in the file.   

 
 

 

 

 

Important 
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7. Follow the steps below to save your file in both the XLS and CSV (Comma delimited) format. 

Step Action Required 

(a)  Click File> Save As> Save as Type> Excel 97-2003 Workbook (*.xls) or Excel Workbook (*.xlsx). 

(b)  In the File name field, enter the roster file name using the suggested naming convention 

<schoolname>_StudentRoster_<mmddyyyy>.xls.  Example:  Idlewood_StudentRoster_08142015.xls 

as the file name. 

(c)  Click Save. 

(d)  Click File> Save As> Save as Type> CSV (Comma Delimited) (*.csv). 

(e)  In the File name field, enter the roster file name using the suggested naming convention 

<schoolname>_StudentRoster_<mmddyyyy>.csv.  Example:  Idlewood_StudentRoster_08142015.csv 

as the file name. 

(f)  Click Save. 

(g)  If you receive a message indicating the file may contain features that are not compatible with the CSV 

format, click Yes. 

 

 

 

Each time you modify the .xls file, you need to repeat Step 7 and resave the file to BOTH the .xls and 

the .csv formats to keep them in sync. Use the .xls version for editing and the .csv version for uploading. 

If you edit the .csv file, it will drop the column attributes defined in the .xls template (e.g., the leading 

zeroes will be dropped from the SSN). This will result in formatting errors the next time you try to 

upload the .csv file.  

 

 

If you used the DECAL template, you can now skip to section – Uploading Your Completed Student 

Roster Files (page 35) – for instructions on how to upload your .csv file.  

Important 
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Creating an Upload File Using the Pre-Populated LSS File from Infinite Campus  

1. In Infinite Campus, navigate to System Administration > Resources > School.  Select the appropriate 

School and enter the Site ID. 

 

To verify your Site ID, go to 

Panda and do the following: 

(a) Click on Pre-K, 

Rosters, and then 

View/Edit Roster. 

(b) On the Provider Site 

List displayed, scroll 

to your County/Site 

Name to locate your 

Site ID. 

 

2. Enter the Panda Class ID on the Section of the Course you will be reporting. Navigate to Search > 

Course/Section > Enter course name or number > Select the section. Bright from the Start Panda 

Class # is on the Section tab. 

 

To determine your Class ID, do 

the following on the View/Edit 

Roster page: 

• Click on your Site 

Name. 

• The Class List page 

displays the Class IDs 

for each class at that 

Site.   

 

 

Note:  You will need to verify your Class ID values each year, as the Class ID values change each 

school year. 

 

3. Populate the specific Pre-K fields listed below into Infinite Campus for each student by navigating to 

Student Info > General > BFTS Data:     
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Enter this data directly into Infinite Campus instead of attempting to edit the extracted csv file.    

 

 

Column – Field  Action Required 

Birth Indicator If the child is from a single birth, twin, or higher-order multiple birth, enter the total 

number of children from the pregnancy as the Multiple Birth value.  

Select Description 

1 If the child was born from a single birth 

2 If the child was born from a twin birth 

3 If the child was born from a triplet birth 

4 If the child was born from a quadruplet birth 

o 

Socio/Economic Select the appropriate Socio-Economic indicator from the drop-down.  

 Category 1    Select this option if the child and/or child’s family participates in one 

of the following: Supplemental Nutrition Assistance program (SNAP), SSI 

(Supplemental Security Income), Medicaid, Temporary Assistance to Needy 

Families (TANF), or Child and Parent Services (CAPS) program. Documentation 

of participation must be verified and kept on file. Children who participate in the 

free and reduced meal program through the school that they attend may also be 

eligible as Category One if income eligibility is verified and kept on file. 

 Category 2    Select this option if the child does not meet the requirements for 

Category 1 eligibility. 

Transportation If the center transports the student to and from Pre-K, select Yes from the Transportation 

drop-down list. If the student is not transported by the Center, select No.   

Funding  Verify that the Class Funding Source displayed is correct and edit this field if needed.    

Select Description 

Blended If the class receives both Head Start and Pre-K funding 

Lottery If the class only receives Pre-K funding 

o 

Waiver Reason 

Code 

If the Student’s SSN was not provided, indicated in Infinite Campus by a ‘999’ social, 

enter the Waiver Reason Code (e.g., 1, 2, 3 …) that corresponds with the reason selected 

by the parent on the Student Social Security Number Information Form.  

Select Description 

1 I need help in obtaining an SSN. 

2 I need help replacing a lost SSN. 

3 I am awaiting a replacement SSN and will provide when it arrives. 

4 I forgot to bring the SSN and will provide within 30 days. 

5 I choose not to provide the SSN because …. 

o 

Waiver Reason 

Detail 

If the Waiver Reason Code = 5, enter the Waiver Reason Detail which is the written 

reason provided by the parent on the Student Social Security Number Information Form. 

 

 

Important 
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4. Repeat step 3 for each Pre-K student in attendance. 

 

5. Once you have completed populating the Pre-K fields for each student, proceed to download the 

Bright from the Start extract for each of your Pre-K sites.  

• Navigate to GA State Reporting > Bright from the Start Extract.  

• Select the desired school(s) and click Download. 

 

6. Save each csv file to a folder on your computer using the following suggested naming convention   

<schoolname>_StudentRoster_<mmddyyyy>.csv.  Example: Idlewood_StudentRoster_08142015.csv 

 

DO NOT open the file in Excel prior to saving it to your computer. 

 

7. If desired, you may double-click on the .csv file you just saved, launching Microsoft Excel, so that you 

can easily verify that all columns are populated and that the correct students are shown and are 

associated with the correct PANDA Site ID and Class ID. Then exit Excel without saving. 

• ONLY VIEW THE FILE IN EXCEL.  

• DO NOT SAVE THE FILE IN EXCEL as this will cause all leading zeroes to be dropped 

from the student’s SSNs triggering records to error out in the upload process. 

 

 

If the Pre-K specific data fields outlined above were NOT entered into Infinite Campus, you will need to 

go back and complete steps 1-4.  It is preferred that the Pre-K data be entered into Infinite Campus rather 

than manually entering it into the extracted files. 

 

 

 

 

 

 

 

 

8. Once your data is accurate and complete, you are ready to upload the file(s) to PANDA.  Proceed to 

the section – Uploading Your Completed Student Roster Files (page 35). 

 

Note:  Because the prepopulated files from LSS are already in CSV format, there is no longer a need 

to maintain both the XLS and CSV file versions as required when using the DECAL template due to 

the prepopulated LSS file containing built-in data validations.  

 

DO NOT edit the saved .csv files. 

If any mistakes are found in the .csv files, do the following: 

 Go back to Infinite Campus and correct the data entry(s) (steps 3 and 4) 

 Generate a new extract file (steps 5 and 6) 

 

X 

Important 
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Creating an Upload File Using the Pre-Populated LSS File from PowerSchool 

1. Provide the PowerSchool Administrator for your district with the PANDA Site IDs for your District.  

They will need to setup the sites on the District page in PowerSchool before the Early Care and 

Learning Pre-K Extract Report (i.e., your pre-populated roster files) can be generated.   

a) To verify your Site ID, go to Panda and click on Pre-K, Rosters, and then View/Edit Roster. 

 

b)  On the Provider Site List displayed, scroll to your County/Site Name to locate your Site ID. 

 

2. Ask the PowerSchool Administrator to ensure that your PowerSchool login has ‘edit’ access, enabling 

you to enter the Pre-K specific fields detailed below for each of your Pre-K students. This data should 

be entered into PowerSchool BEFORE the pre-populated files are generated.   

 

 

 

If a Data Entry Clerk will be responsible for entering the Pre-K student data into PowerSchool, 

provide them the Roster Information Form (Appendix D) for each student.  Enter this data 

directly into PowerSchool rather than attempting to edit the csv files. 

 

 

A parent may provide the student’s Social Security Number (SSN) on the Roster Information Form 

even though they may not have previously provided it on any other school forms.  If the SSN is 

present on the Pre-K form, verify that it has been entered into PowerSchool. 

 

3. Populate the specific Pre-K fields listed below into PowerSchool for each student:     

 

Important 
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Field Action Required 

Panda Class ID  Enter the PANDA Class ID.   

(a) Go to Panda and click on Pre-K, Rosters, and then View/Edit Roster. 

(b) To determine your Class ID, click on your Site Name.  

(c) The Class List Page displays the Class IDs for each class at that Site.   

 

Note:  You will need to verify your Class ID values each year, as the Class ID values 

change each school year.0 

Pre-K Program 

Code  

Select the appropriate Pre-K Program Code from the dropdown. This represents what is 

known as the Class Funding Source in PANDA.    

Select Description 

Blended If the class receives both Head Start and Pre-K funding 

Lottery If the class only receives Pre-K funding 

O 

Multiple Birth 

Value  

If the child is from a single birth, twin, or higher-order multiple birth, select the number of 

children from the Multiple Birth drop-down list.  

Select Description 

1 If the child was born from a single birth 

2 If the child was born from a twin birth 

3 If the child was born from a triplet birth 

4 If the child was born from a quadruplet birth 

o 

Dual Language 

Learner 

Check the Dual Language Learner checkbox if English is not the student’s primary language; 

otherwise, leave the checkbox ‘blank’. 

Socio Economic 

Indicator 

Select the appropriate Socio-Economic indicator from the drop-down.  

 Category 1    Select this option if the child and/or child’s family participates in one of 

the following: Supplemental Nutrition Assistance program (SNAP), SSI (Supplemental 

Security Income), Medicaid, Temporary Assistance to Needy Families (TANF), or 

Child and Parent Services (CAPS) program. Documentation of participation must be 

verified and kept on file. Children who participate in the free and reduced meal program 

through the school that they attend may also be eligible as Category One if income 

eligibility is verified and kept on file. 

 Category 2    Select this option if the child does not meet the requirements for Category 

1 eligibility. 

Transportation 

will be provided 

Check the Transportation checkbox if the program transports the student to and from Pre-K. 

If transportation is not provided, leave the checkbox ‘blank’.   
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Field Action Required 

Waiver Reason 

Code 

If the Student’s SSN was not provided, indicated in PowerSchool by a ‘999’ social, select the 

Waiver Reason Code (e.g., 1, 2, 3 …) that corresponds with the reason selected by the parent 

on the Student Social Security Number Information Form: 

Select Description 

1 I need help in obtaining an SSN. 

2 I need help replacing a lost SSN. 

3 I am awaiting a replacement SSN and will provide when it arrives. 

4 I forgot to bring the SSN and will provide within 30 days. 

5 I choose not to provide the SSN because …. 

O 

Waiver Reason 

Detail 

If the Waiver Reason Code = 5, enter the Waiver Reason Detail which is the handwritten 

reason given by the parent on the Student Social Security Number Information Form. 

 

4. Repeat step 3 for each Pre-K student in attendance.  

 

5. From the report’s menu available in PowerSchool, request the Early Care and Learning PK Extract 

Report for each of your Pre-K sites.   

a) Contact your PowerSchool Administrator if you need assistance.  

b) Save each csv file to a folder on your computer using the following suggested naming 

convention <schoolname>_StudentRoster_<mmddyyyy>.csv.  Example:  

Idlewood_StudentRoster_08142015.csv as the file name. 

 

DO NOT open the file in Excel prior to saving it to your computer. 

 

6. If desired, you may double-click on the .csv file you just saved, launching Microsoft Excel, so that you 

can easily verify that all columns are populated and that the correct students are shown and are 

associated with the correct PANDA Site ID and Class ID. Then exit Excel without saving. 

a) ONLY VIEW THE FILE IN EXCEL.  

b) DO NOT SAVE THE FILE IN EXCEL as this will cause all leading zeroes to be dropped 

from the student’s SSNs triggering records to error out in the upload process. 
 

 

 

If the Pre-K specific data fields outlined above were NOT entered into PowerSchool, you will need to 

go back and complete steps 2-4.  All Pre-K data must be entered into PowerSchool rather than manually 

entering the data into the extracted files. 

 

 

 

 

 

 

DO NOT edit the saved .csv files. 

If any mistakes are found in the .csv files, do the following: 

 Go back to PowerSchool and correct the data entry(s) (steps 3 and 4) 

 Generate a new extract file (steps 5 and 6) 

 

X 

Important 
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7. Once your files are accurate and complete, you are ready to upload them to PANDA. Proceed to the 

next section – Upload Your Completed Student Roster Files (page 35). 

 

Note:  Because the prepopulated files from LSS are already in CSV format, there is no longer a need 

to maintain both the XLS and CSV file versions as required when using the DECAL template due to 

the prepopulated LSS file containing built-in data validations.  
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Creating an Upload File Using the Pre-Populated LSS File from ASPEN 

1. Work with your ASPEN district coordinator to ensure the State Codes have been updated in the Person 

Relationship Codes Table. The only acceptable values that can be reported in the PANDA Export are:  

Mother, Father, Grandparent, and Guardian. Assign these state codes to the appropriate values in the 

State Code column in the below reference table.   

 
  

2. Have your ASPEN district coordinator ensure that the School table has the correct PANDA Site Id 

values and that the Schedule Master table has the correct PANDA Class ID values for our location. 

The Site IDs remain the same each year. Please note that new Class IDs are assigned each year.    

 

The Site ID and Class ID values can be found in PANDA on the View/Edit Roster screens as shown 

below: 

Value Action Required in PANDA 

Site ID (a) Click on Pre-K, 

Rosters, and then 

View/Edit 

Roster. 

(b) On the Provider 

Site List page 

displayed, scroll 

to your 

County/Site 

Name to locate 

the Site ID. 
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Value Action Required in PANDA 

Class ID (a) On the View/Edit 

Roster page, click 

on your Site Name. 

(b) The Class List page 

displays the Class 

IDs for each class at 

that Site. 

 

 

 

3. Populate the specific Pre-K fields listed below into ASPEN for each student.   

  

All of the data fields have been created with List Edit ability, so users can easily update the student 

data using list view if desired. 

Column – Field  Action Required 

Birth Indicator If the child is from a single birth, twin, or higher-order multiple birth, enter the total 

number of children from the pregnancy as the Multiple Birth value.  

Select Description 

1 If the child was born from a single birth 

2 If the child was born from a twin birth 

3 If the child was born from a triplet birth 

4 If the child was born from a quadruplet birth 

o 

Socio/Economic Select the appropriate Socio-Economic indicator from the drop-down.  

 Category 1    Select this option if the child and/or child’s family participates in one 

of the following: Supplemental Nutrition Assistance program (SNAP), SSI 

(Supplemental Security Income), Medicaid, Temporary Assistance to Needy 

2023 
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Column – Field  Action Required 

Families (TANF), or Child and Parent Services (CAPS) program. Documentation 

of participation must be verified and kept on file. Children who participate in the 

free and reduced meal program through the school that they attend may also be 

eligible as Category One if income eligibility is verified and kept on file. 

 Category 2    Select this option if the child does not meet the requirements for 

Category 1 eligibility. 

Transportation If the center transports the student to and from Pre-K, select Yes from the Transportation 

drop-down list. If the student is not transported by the Center, select No.   

Funding  Verify that the Class Funding Source displayed is correct and edit this field if needed.    

Select Description 

Blended If the class receives both Head Start and Pre-K funding 

Lottery If the class only receives Pre-K funding 

o 

Waiver Reason 

Code 

If the Student’s SSN was not provided, indicated in ASPEN by a ‘999’ social, enter the 

Waiver Reason Code (e.g., 1, 2, 3 …) that corresponds with the reason selected by the 

Parent on the Social Security Number Information Form. 

Select Description 

1 I need help in obtaining an SSN. 

2 I need help replacing a lost SSN. 

3 I am awaiting a replacement SSN and will provide when it arrives. 

4 I forgot to bring the SSN and will provide within 30 days. 

5 I choose not to provide the SSN because …. 

o 

Waiver Reason 

Detail 

If the Waiver Reason Code = 5, enter the Waiver Reason Detail which is the handwritten 

reason given by the Parent on the Social Security Number Information Form. 

 

4. Repeat step 3 for each Pre-K student in attendance. 

 

 

Be sure to flag only the homeroom class in the Student Schedule table in ASPEN for each child.  

Otherwise this will cause duplicates in the csv file and we need to ensure each child has only 1 

record in the file. 

 

5. Once you have completed populating the Pre-K fields for each student, proceed to download the GA 

PANDA Roster Export. We recommend pulling a separate export for each Site within your district.   

 

6. Save each csv file to a folder on your computer using the following suggested naming convention   

<schoolname>_StudentRoster_<mmddyyyy>.csv.  Example: Idlewood_StudentRoster_08142015.csv   
 

DO NOT open the file in Excel prior to saving it to your computer. 
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7. If desired, you may double-click on the .csv file you just saved, launching Microsoft Excel, so that you 

can easily verify that all columns are populated and that the correct students are shown and are 

associated with the correct PANDA Site ID and Class ID.  Then exit Excel without saving. 

• ONLY VIEW THE FILE IN EXCEL.  

• DO NOT SAVE THE FILE IN EXCEL as this will cause all leading zeroes to be dropped 

from the student’s SSNs triggering records to error out in the upload process. 

 

 

 

If the Pre-K specific data fields outlined above were NOT entered into ASPEN, you will need to go back 

and complete steps 3 and 4.  It is preferred that the Pre-K data be entered into ASPEN directly rather 

than manually entering the data into the extracted files. 

 

 

 

 

 

 

 

 

8. Once your data is accurate and complete, you are ready to upload the file(s) to PANDA.  Proceed to 

the section – Uploading Your Completed Student Roster Files (page 35). 

 

Note:  Because the prepopulated files from ASPEN are already in CSV format, there is no longer a 

need to maintain both the XLS and CSV file versions as required when using the DECAL template due 

to the prepopulated LSS file containing built-in data validations.  

 

  

DO NOT edit the saved .csv files. 

If any mistakes are found in the .csv files, do the following: 

 Go back to ASPEN and correct the data entry(s) (steps 3 and 4) 

 Generate a new extract file (steps 5 and 6) 

 

X 

Important 
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Creating an Upload File from ChildPlus 

1. In ChildPlus, navigate to Reports > Enrollment.  Scroll down and select the DECAL Custom 

Enrollment Report, which is Report #2101Z. 

  
 

2. Using the dropdown arrows, select the Program Term value of ‘Georgia Pre-K’ for the current 

school year, then select the appropriate Agency/Site/Classroom combination for the file(s) you wish 

to create.    

 
 

3. Click on ‘Export’ and save the file to your computer, being sure to save as type ‘Excel Spreadsheet 

– Data Only(*.xlsx)’.  We recommend that you include the Site Name in the filename 
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4. Once the Export has completed, select the ‘Open the File’ option, as you will need to edit the file 

in Excel to populate the Pre-K specific fields listed below for each student, since these fields are 

not stored in ChildPlus. 

 
 

Column – Field Action Required 

A – Site ID Enter the Site ID for the class you are uploading. 

(c) To verify your Site ID, go to Panda and click on Pre-K, Rosters, and then 

View/Edit Roster. 

(d) On the Provider Site List page displayed, scroll to your County/Site Name 

to locate the Site ID.  
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Column – Field Action Required 

 

B – Class # Enter the Class ID.  

(c) To determine your Class ID, click on your Site Name. 

(d) The Class List page displays the Class IDs for each class at that Site. 

 

 

Birth Indicator If the child is from a single birth, twin, or higher-order multiple birth, enter the total 

number of children from the pregnancy as the Multiple Birth value.  

Select Description 

1 If the child was born from a single birth 

2 If the child was born from a twin birth 

3 If the child was born from a triplet birth 

4 If the child was born from a quadruplet birth 

o 

Socio/Economic  Enter ‘Category 1’ if the child and/or child’s family participates in one of the 

following: Supplemental Nutrition Assistance program (SNAP), SSI (Supplemental 

Security Income), Medicaid, Temporary Assistance to Needy Families (TANF), or 

Child and Parent Services (CAPS) program. Documentation of participation must 

be verified and kept on file. Children who participate in the free and reduced meal 

program through the school that they attend may also be eligible as Category One if 

income eligibility is verified and kept on file. 

 Enter ‘Category 2’ if the child does not meet the requirements for Category 1 

eligibility. 

2023  

03 

DeKalb 

Emily Dickinson 

Conyers County Board of Education 

03 

DeKalb 

Emily Dickinson 
 



 Student Data Training Document 

Bright from the Start : Georgia Department of Early Care and Learning Page 34 of 57 

Dual Language 

Learner 

Indicator 

Enter ‘Yes’ or ‘Y’ if English is not the student’s primary language; otherwise, enter ‘No’ 

or ‘N’.   

Funding   Enter ‘Blended’ if the class receives both Head Start and Georgia’s Pre-K funding. 

 Enter ‘Lottery’ if the class only receives Pre-K funding. 

Waiver Reason 

Code 

If the Student’s SSN was not provided, enter the Waiver Reason Code (e.g., 1, 2, 3 …) 

that corresponds with the reason selected by the parent on the Student Social Security 

Number Information Form. 

Select Description 

1 I need help in obtaining an SSN. 

2 I need help replacing a lost SSN. 

3 I am awaiting a replacement SSN and will provide when it arrives. 

4 I forgot to bring the SSN and will provide within 30 days. 

5 I choose not to provide the SSN because …. 

o 

Waiver Reason 

Detail 

If the Waiver Reason Code = 5, enter the Waiver Reason Detail which is the handwritten 

reason given by the parent on the Student Social Security Number Information Form. 

 

5. Repeat Step 4 for each student until all students for the respective Site/Class(es) have been 

populated. 

 

6. Follow the steps below to save your file in both the XLS and CSV (Comma delimited) format. 

Step Action Required 

(h)  Click File> Save As> Save as Type> Excel 97-2003 Workbook (*.xls) or Excel Workbook (*.xlsx). 

(i)  In the File name field, enter the roster file name using the suggested naming convention 

<schoolname>_StudentRoster_<mmddyyyy>.xls.  Example:  Idlewood_StudentRoster_08142015.xls 

as the file name. 

(j)  Click Save. 

(k)  Click File> Save As> Save as Type> CSV (Comma Delimited) (*.csv). 

(l)  In the File name field, enter the roster file name using the suggested naming convention 

<schoolname>_StudentRoster_<mmddyyyy>.csv.  Example:  Idlewood_StudentRoster_08142015.csv 

as the file name. 

(m)  Click Save. 

(n)  If you receive a message indicating the file may contain features that are not compatible with the CSV 

format, click Yes. 

 

 

 

Each time you modify the .xls file, you need to repeat Step 6 and resave the file to BOTH the .xls and 

the .csv formats to keep them in sync. Use the .xls version for editing and the .csv version for uploading. 

If you edit the .csv file, it will drop the column attributes defined in the .xls template (e.g., the leading 

zeroes will be dropped from the SSN). This will result in formatting errors the next time you try to 

upload the .csv file.  

Important 
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Uploading Your Completed Student Roster Files  

When your upload file(s) are ready, complete the following steps to upload your student roster data. 

1. On PANDA’s main menu, click Pre-K, Rosters, and then the View Roster Upload Status. The View 

Upload Status window displays.  

 

2. Click .  

 

3. On the Upload File window, click on Choose File or enter the full path to the desired roster .csv file. 

 
 

4. Click .   

• If the specified file was successfully retrieved, PANDA displays a message on the screen that 

the uploaded file was accepted for processing.  

• If the file was not found or was not a .csv file, an error message will display. 

 

5. Click  to return to the View Upload Status screen where you can monitor the progress of the 

upload by clicking . You will receive e-mails from PANDA confirming when a file is 

received, if an error occurred, or if records were successfully loaded to the roster. 

 

Please note that if the number of students loaded to the roster is less than the number of students in the 

upload file, then it means one or more students were flagged to the Student Exceptions screen. Refer to the 

next section of this document regarding how to resolve exception so that all students will pass on through 

the process and load to your roster. 
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View Roster Upload Status and Resolve Upload Exceptions 

 

 

After you upload your roster files to DECAL, you must check the upload status and resolve any data 

errors. Failure to resolve the student exceptions will prevent all students from loading to the roster. 

DO NOT ignore errors or attempt to manually add the missing students. 

 

To check the status of your upload and resolve potential errors, complete the following steps: 

1. On the View Roster Upload Status page, click the  button to view the student file upload 

status.  

 
 

The status for all files loaded thus far during Roster 1 of the current school year will display.   

 

2. Continue to click on the Search/Refresh button to refresh the information displayed until the file 

being loaded has completed the validation/upload process.    

 

3. The following table describes the possible status values that may be received during the upload process: 

Upload Status Description 

File Received For 

Validation 

This indicates the file was successfully located and the validation process has 

started.   

Total No. of Fields in 

one or all rows in 

incorrect 

This indicates there is a problem with the file layout itself on one or more rows in 

the file.  Typical reasons a file layout error occurs include: 

• An empty file was uploaded. 

• Records in the file have too many columns or not enough columns. Each 

row should only contain 26 columns.   

Invalid Site/Class 

Combination 

This indicates that one or more records in the file contains an invalid Site ID or 

Class ID.   

Note:  The upload process will stop if even just one invalid record is found. You 

will need to correct your file and upload again. 

Validation In 

Progress 

The roster file that you uploaded has passed the file layout validations and the 

record is being validated against the data edits for each individual field on the 

record. 

Conyers County Schools 

 

Conyers County Schools 

 

Conyers County Schools 

 

Conyers County Schools 

 

Important 
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Upload Status Description 

Upload Exception PANDA found invalid values on one or more student records.   

Note:  All valid records will load to the roster, but you will need to correct the 

records that have exceptions in order for them to load. The correction process is 

described starting on step 4. 

Validated The roster validation of each individual field for each student is complete and no 

errors were found. 

Save In Progress After the roster has been successfully validated and the records have loaded to the 

database, its status changes to Save In Progress. The roster is ready to be reviewed 

and marked as ‘Roster Updates Complete’. 

 

4. If you received the Upload Exception error, click on the yellow Select box  next to the File ID to 

display the Error Report screen. Each student that was flagged with an error will be listed. 

 

5. Select a student record by clicking the yellow Select box  next to the student’s name.  

 
 

6. The Student Error Correction screen displays showing the specific field (s) that contain invalid 

information. 

Conyers County Schools 

BrightStart_studentroster_09062018.csv 

32 
 

9/6/2023  11:21:41 AM 

Yes 

0 
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Note:  If you have a small number of students with errors, it will be easier to correct them on the 

Student Error Correction screen. However, if most of your records have errors, you may find it easier 

to update your file and perform the upload steps again. 

 

7. Review the student’s record and enter your corrections in the Correct Information column.  

 

8. Click the  button to save your changes for the student. 

 

9. Click  to return to the Student Error report. The corrected student record is no longer listed on 

the report and the Number of Error Records is reduced by one. 

 

10. Repeat steps 5-8 for each student listed on the Error Report screen. When you are finished, return to 

the View Upload Status screen.  

 

11. Click the  button. The upload file status should now show Save In Progress, and you 

are ready to review your roster to confirm all data shown is correct. Once all classes are complete and 

the Count Date has arrived, you are ready to click on Roster Updates Complete and submit your 

roster for each Site by following the instructions on the next page.      

 

 

 

Once you have successfully uploaded your students, DO NOT upload the file again for the same class 

or it will wipe out the students already loaded.   

 

NOTE 1:  If a new student arrives after you have completed the roster upload process and on/before the   

                 Count Date, simply add this student to your roster manually.   

 

NOTE 2:  If your upload file contains multiple classes and all have loaded successfully except one class, 

                 we can assist you with splitting that one class to its own upload file so that you are not 

                 continually dropping/reprocessing all classes every time.  For assistance with roster upload 

                 questions, email panda.rosters@decal.ga.gov.  

Important 

Conyers County Schools 

131 Disney Lane, Anywhere, Georgia 33300 

(555)477-6937 

mailto:panda.rosters@decal.ga.gov
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Submitting Your Completed Roster to DECAL 

1. When you have entered/verified all of the teacher and student data on your roster(s), click the    

 button located at the bottom of the Roster Details page.   

Note:  If there are any errors, a message will appear at the top of the screen. The roster status will not 

change to Roster Updates Complete until the error(s) has been resolved. Note that in some browsers, 

you may not be able to scroll up to see the popup message. If that occurs, change your zoom level and 

ensure you have enabled popups. 

 

2. Click the  button. The Roster Class List screen displays. Notice the roster status field shows 

Roster Updates Complete. 

 
 

3. Click the  button to review the roster status for each site. After all classes are marked 

complete, the site status will display Roster Updates Complete. The site can then be submitted 

beginning on the count date for each roster cycle. 

 

4. To submit the site: (a) read the statement below the site(s) information, (b) click the white checkbox to 

the left of the Site ID, and then (c) click Continue.  

 

 

 

Only the Project Director or users with the Provider Management role will be able to see the 

Continue button and submit the roster.  The ‘Continue button is not accessible to users who have not 

been assigned the Provider Management role or are trying to submit prior to the count date. 

   

Important 

2023 
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5. The following Roster Submission popup screen will be displayed. Read the message very carefully 

before proceeding.  

 
 

6. Choose one of the following options: 

Select Condition 

Accept If you concur that all of the data entered is true, complete and accurate to the best of your 

knowledge, and that you understand any false, fraudulent, or fictitious representation is 

punishable by law and could result in a felony charge.  

Return to 

Roster 

If you are unsure and need to go back and carefully review the data entered – wait to 

submit until you have verified the data is correct. 

 

If you fail to include a student on a roster submitted to DECAL, you can add the student to the 

next roster; however, you cannot back date the entry to correct the mistake.  The begin date you 

enter must be greater than the count date of the previous roster.  Carefully review each roster for 

accuracy BEFORE submitting. Providers that inadvertently report inaccurate roster data may be 

charged a fee. Refer to Section 18.6 of the Pre-K Providers’ Operating Guidelines for details.  

 
 

7. After selecting Accept, complete the submission process by clicking the Submit button. The site's 

Roster Status will change to Submitted.  

 

You will receive a confirmation e-mail informing you that your roster has been successfully submitted 

to DECAL. The e-mail will include the number of classes that were submitted. If all classes were not 

submitted, go back to the roster to see which classes did not submit successfully. 

 

 

By submitting the roster(s), you are asserting via electronic signature that the information on the 

roster(s) is true, complete, accurate, and includes all available student and teacher information.  

 

 

Important 

 



 Student Data Training Document 

Bright from the Start : Georgia Department of Early Care and Learning Page 42 of 57 

Printing a PANDA Roster Report 

After you finish entering your rosters, you can generate the PANDA Roster Report. This report lists the 

lead teacher, assistant teacher, and students enrolled in each class on the count day.      

1. In PANDA, select View/Edit Roster and pull up the desired Site or Class.   

 

2. Whether pulling the report at the Provider level, Site level, or individual Class level, each roster screen 

will display two Print options:  

Level  Action Required 

Provider Navigate to the View/Edit Roster window and click on either Provider Roster Report or 

Provider Roster Reports w/o SSN in the upper right corner. 

 

Site Navigate to the View/Edit Roster window and click on the Site Name.  The Roster Class 

List window displays. In the upper right corner, click Reports and select either Site 

Roster Report or Site Roster Reports w/o SSN. 

   

Class Navigate to the Roster Class List and click the Class ID. In the upper right corner on the 

Roster Class List window, click Print or Print Without SSN. 

 

 

3. Use the following criteria to determine which print option to select: 

Select Condition 

❑ Provider Roster Report  

❑ Site Roster Report  

❑ Print  

The report generated by selecting either the Provider Roster 

Report, Site Roster Report, or Print button should ONLY 

be viewed by the Project Director to confirm data accuracy 

(if you prefer not to view it online for accuracy), as this 

report contains SSN’s.  

 

Please take appropriate action to shred the report once 

you have finished verifying/correcting the roster data. 

❑ Provider Roster Reports w/o SSN 

❑ Site Roster Reports w/o SSN 

❑ Print Without SSN 

The report generated does not contain the SSN’s. This report 

should be printed and given to the Lead Teacher for each 

Pre-K class in your program. Teachers will need the PANDA 

Student ID from this report to accurately enter their students 

into the Work Sampling Online (WSO) System. 
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4. The PANDA Roster Report will display in a separate browser window. You can then select the Print 

icon ( ), export to another file type (i.e., PDF, Excel, Word, etc.,), or you can save the Without SSN 

version to a file to e-mail to the teacher if she works at a different location from the Project Director. 
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Updating Student Information Roster 

1. On the View/Edit Roster screen, click the Site Name hyperlink for the desired site. The Class List 

page displays. 
 

2. Click the Class ID hyperlink next to the class that you want to update. The Class Roster page displays.   
 

3. Follow the steps below to make your changes:  

Fields Impacts 

Funding 
Action Required 

Gender, 

Multiple Birth, 

and IEP  

No The fields are displayed as hyperlinks.   

(a) Locate the student’s name on the roster and click the field that needs to be changed. 

 

(b) The field menu opens.   

(c) Select the correct value and then click  to save the changes. 

Gender, 

Multiple Birth, 

DLL, IEP, 

Funding, 

Ethnicity, 

Race, Parent 

Name, 

Relationship 

No (a) Click on the student’s last name. 

 

(b) Click on Edit in the upper right corner of the Student Information window. 

  

(c) After you make the necessary change(s), click Save to update the record. 

Transportation 

and 

Socio/Economic 

 

 

Yes Updates to these fields require the addition of an effective or start date as changes 

will impact the amount of your Pre-K funding:  

(a) Click on the student’s last name. 

(b) Click on Chg Trans/Socio in the upper right corner of the Student Information 

window. Transportation and Socio/Economic are the only editable fields. 

(c) After you make the necessary change(s), the system will prompt you for an 

Effective date of Change. To determine the effective date: 

If Then 

Changing 

Transportation 

from NO to 

YES 

Enter the date you began providing transportation for the 

student. If you ALWAYS provided transportation for this 

student, then the effective date should be the next day after the 

BEGIN date in class. 

Changing 

Transportation 

from YES to 

NO 

Enter the date you stopped providing transportation for the 

student. If you never provided transportation for the student, 

then the effective date should be the next day after the BEGIN 

date in class. 

Changing from 

Category 1 to 

Category 2 

Enter the date the student became INELIGIBLE for Category 1 

status. If the student was NEVER eligible, then the effective 

date should be the next day after the begin date in class. 

Changing from 

Category 2 to 

Category 1 

Enter the date the student became ELIGIBLE for Category 1 

status. If the student was ALWLAYS eligible, then the effective 

date should be the next day after the begin date in class. 

(d) Enter the effective date and click Save to update the record. 
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Fields Impacts 

Funding 
Action Required 

 

Example Roster View After Transportation Change: 

 

NOTE:  A Category or Transportation change does not change the student’s original 

Begin Date. Both an ‘open’ record and a ‘closed’ record will appear for the student 

during the roster in which a change was made to the Transportation or 

Socio/Economic indicators. The closed record WILL NOT appear on subsequent 

rosters. The student WILL retain their original Begin Date. The Begin Date on the 

newly opened record merely reflects when the change in Transportation or 

Socio/Economic began.  The original start date can be viewed on the Child Search 

screen or by selecting a prior Roster Cycle at the top of the View Roster Class List 

screen. 

Name and/or 

Date of Birth 

Name - 

No 

Date of 

Birth 

may 

impact 

funding 

To correct names and/or birth dates, complete the Pre-K Roster Correction 

Request Form found on the Project Director page of our website and email it to 

panda.rosters@decal.ga.gov.   

DO NOT close and re-add the student. This will flag them as a duplicate which will 

result in you being contacted by DECAL to provide all this student’s documentation. 

SSN No - If SSN was initially left blank and you have now obtained the number, it can be 

entered by clicking on the ‘Populate SSN’ hyperlink. 

 

- To request a correction to an SSN previously entered, complete the Pre-K Roster 

Correction Request Form found on the Project Director page of our website and 

email it to panda.rosters@decal.ga.gov.   

DO NOT close and re-add the student as this will flag the student as a duplicate. 

 

 

 

 

 

http://www.decal.ga.gov/PreK/ProjectDirectors.aspx
http://www.decal.ga.gov/PreK/ProjectDirectors.aspx
mailto:panda.rosters@decal.ga.gov
http://www.decal.ga.gov/PreK/ProjectDirectors.aspx
http://www.decal.ga.gov/PreK/ProjectDirectors.aspx
mailto:panda.rosters@decal.ga.gov
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Moving a Student From One Class to Another 

If the student has moved to another class within your program, complete the following steps that will close 

the students record in their current class and will create the students record in their new class: 

1. On the current open roster, click on the student’s Last Name to open the selected student’s information 

window. 
 

2. Click the Move Student button at the top of the screen.  The Transfer Student pop up window 

displays. 

 

 
 

3. Click on the calendar icon ( ) to select the End Date in the old class OR click in the box if the 

student never attended the class. 

 

4. Click on the Select Site drop down and select the site the student is moving to. 
 

5. Click on the Select Class drop down and select the class the student is moving to. 
 

6. Click on the calendar icon ( ) to select the Begin Date in the new class.    
 

7. Click Save. 
 

8. If moving the student will not exceed the maximum allowance of enrolled students: 

(a) PANDA will close the student in their current class (with an End Date that is the day before 

the Begin Date in the new class) and will add them to the new class. 

(b) Record moved successfully will display.    

(c) Click OK to return to the roster.  
 

9. If moving the student exceeds the maximum allowance of enrolled students: 

(a) PANDA will display the following error: 
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(b) Review the roster of the new class and follow the steps given further below to Close any 

student(s) who have withdrawn from the class. 

(c) Repeat the above steps to again try to move the desired student to the new class.  
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Moving a Student from RPK to PK 
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Closing a Student  

If a student has withdrawn, complete the following steps to close the students record: 

1. On the current open roster, click on the student’s last name to open the selected student’s information 

window.  

 

2. Click the Close Student button at the top of the screen. The Close Student pop up window displays. 

  

3. Click on the calendar icon ( ) to select the last date of attendance. 

 

4. Click Save to update the record. 
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Adding a Returning Student  

 

If a student who previously attended Pre-K within your program has now returned, complete the following 

steps to re-add the student to your roster: 

 

1. Using the View/Edit Roster menu option, navigate to the appropriate Site and Class of where the 

student will be attending.    

 

2. On the roster details screen, scroll down to the Student Information section and click the Add 

button. 

 

3. The Student Information screen displays as shown below.   

 
 

4. Select the Add Returning Student button.  A list of all students who have previously withdrawn 

will display.  Click the circle next to the desired student and click ‘Ok’. 
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5. A validation pop-up will appear as shown below.  Click ‘Yes’.   

 

 
 

6. All fields will pre-populate for you so that you do not have to re-key in any of the student 

information, thus eliminating potential data entry errors that could cause a duplicate.  You will be 

able to edit/update all fields except for the Name/DOB/Social/Gender.  If any of those were 

incorrect on the student’s initial record and need to be corrected, please proceed to the ‘How To 

Update A Student On Your Roster’ section within this document. 

 

7. Enter the desired Begin Date for this student and click on ‘Save’. 
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How to Search for a Student within Your Program 

1. In the left-side navigation menu, select (a) Pre-K, click on (b) Rosters, and then select (c) Search 

Child. 

 
 

 

2. In the Search Child window, use the Year dropdown menu to select the desired calendar year. 

 

3. In one or more of the search criteria fields, enter the student’s Last Name, First Name, Middle Name, 

Student ID, etc. and click Search.  

  
 

Search Tips:   

• If you are unsure of the spelling of a student’s name, you can enter a partial first or last name 

to give you a list of possible students. 

• The field values are not case-sensitive, therefore upper- or lower-case letters will yield the 

same results. 

• Start with a broad search using only one field and then narrow your search down using two or 

more fields. 
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4. All records that meet the search criteria are displayed. If you do not obtain the results you were 

expecting, check for spelling or typing errors.  

 

5. The Child Name column displays each student’s name as a hyperlink. Click on the student’s name to 

view the record details. 
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Frequently Asked Questions 

Q. What is the difference between the count date and the due date? 

A. The count date is the day providers verify students who are actively enrolled and attending Pre-K and 

teachers who are currently employed and teaching in the class. The due date is the day by which the 

roster must be submitted to DECAL.  

 

The roster cannot be submitted prior to the count date. Providers may begin submitting the roster on 

or after the count date and can continually report changes that occur in the class until the end of the 

count date. Rosters are required to be submitted by the due date which is generally one week following 

the count date. 

 

Any changes that occur after the count date will be reported on the next roster. No students can be 

added to the roster after the final count date.   

 

Refer to section 18.6 of the Pre-K Providers’ Operating Guidelines for a list of Critical Reporting 

Dates. 

 

Q. One of my students has withdrawn.  How do I remove the student from the roster? 

A. On the current open roster, click on the student’s last name to open the selected student’s information 

window. Click the Close Student button at the top of the screen. Enter the last date of attendance and 

click Save to update the record. 

 
 

 

Q. How do I make corrections to the Gender, Multiple Birth, and, IEP roster fields? 

A. To correct Gender, Multiple Birth, and IEP, find the student’s name on the roster, click the field 

(blue link) that needs to be changed, make the needed change, and then save the entry. 

 

Q. How do I make corrections to the Category or Transportation roster fields? 

A. If you need to edit the Category or Transportation fields, complete the following steps: 

Step Action Required 

(1)  Click on the yellow Select box next to the student’s name. 

(2)  Click on the Chg Trans/Socio button at the top of the Student Information window.  Transportation 

and Socio/Economic are the only editable fields. 
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Step Action Required 

(3)  After you select an option from the drop-down list, the system will prompt you for an Effective date 

of Change. To determine the date: 

If Then 

Changing 

Transportation 

from NO to 

YES 

Enter the date you began providing transportation for the student. If you 

ALWAYS provided transportation for this student then effective date should be 

the next day after the BEGIN date in class. 

Changing 

Transportation 

from YES to 

NO 

Enter the date you stopped providing transportation for the student. If you never 

provided transportation for the student, then the effective date should be the 

next day after the BEGIN date in class. 

Changing from 

Category 1 to 

Category 2 

Enter the date the student became INELIGIBLE for Category 1 status. If the 

student was NEVER eligible, then the effective date should be the next day 

after the begin date in class. 

Changing from 

Category 2 to 

Category 1 

Enter the date the student became ELIGIBLE for Category 1 status. If the 

student was ALWLAYS eligible, then the effective date should be the next day 

after the begin date in class. 
o 

(4)  Enter the effective date. 

(5)  Click Save to update the record. 

 

NOTE:  A Category or Transportation change does not change the student’s original Begin Date. Both an ‘open’ record 

and a ‘closed’ record will appear for the student during the roster in which a change was made to the Transportation or 

Socio/Economic indicators. The closed record WILL NOT appear on subsequent rosters. The student WILL retain their 

original Begin Date. The Begin Date on the newly opened record merely reflects when the change in Transportation or 

Socio/Economic began.  The original start date can be viewed on the Child Search screen or by selecting a prior Roster 

Cycle at the top of the View Roster Class List screen. 

 

Q.  Why is a Begin Date showing for my student that is different from what I entered and no longer 

matches their first day of attendance? 

A.  Use the Child Search menu option to view the student’s enrollment history.  Verify if the student had a 

change in Socio/Economic or Transportation on a previous roster.  During the roster in which the change 

was made, both an ‘open’ and a ‘closed’ record will appear for the student.  The closed record will not 

appear on subsequent rosters but it is still in the system. No start date correction is needed since the 

previous roster still reflects the student’s original begin date. The original start date can be viewed on the 

Child Search screen or by selecting a prior Roster Cycle at the top of the View Roster Class List screen. 

 

A. How do I make corrections to the SSN, Name, or Date of Birth roster fields? 

A. If you need to correct a student’s SSN, Name, or Date of Birth, complete the Pre-K Roster Correction 

Request Form (located at http://decal.ga.gov/PreK/ProjectDirectors.aspx) and email it to 

panda.rosters@decal.ga.gov.  DO NOT close and re-enter the student as this will flag the student as a 

duplicate. 

 

Q. We have a student who has had a legal name change.  Do we need to do anything? 

A.  Yes. You should take the following actions: 

1. Complete the Pre-K Roster Correction Request Form (see above question for location of this 

form) and email it to panda.rosters@decal.ga.gov so that DECAL staff can update your roster.  

2. Inform the student’s teacher of the change in name so that the teacher can update the WSO roster. 

http://decal.ga.gov/PreK/ProjectDirectors.aspx
mailto:panda.rosters@decal.ga.gov
mailto:panda.rosters@decal.ga.gov
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3. If you are a public school, make sure your registrar has been informed of this change and has 

entered it into Infinite Campus, PowerSchool or ASPEN.  Ask that they also help keep you 

informed anytime they make any changes in their system to a Pre-K student. 

 

Q. A parent has provided the Social Security number (SSN) for a student already on the roster. 

How do I add the SSN? 

A. SSNs can be added during open roster periods. Any child without an SSN listed will have the words 

POPULATE SSN in the SSN field on the roster. After you locate the student on the roster, click on 

the POPULATE SSN link, enter the student’s SSN, double check your entry for accuracy, and then 

click Save. 

 

Q.   How do I move a student from one class to another within my program? 

A) On the current open roster, click on the student’s last name to open the selected student’s information 

window. Click the Move Student button at the top of the screen. Enter the End Date in the original 

class or click the box if the student never physically attended in the class, select the desired Site Name, 

select the desired Class Id, and enter the begin date of attendance in the new class. 

   
 

 

Q. I uploaded my first roster and am now trying to ‘Add’ an additional student manually to Roster 

1. Why am I receiving this popup? 
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A.  If the roster upload process resulted with upload exceptions and not all students in the roster upload file 

were loaded to the roster, you will receive the above popup if you leave those exception unresolved and 

you try to add a student manually. Confirm that the student you are trying to add is not in the list of upload 

exceptions by clicking on the green ‘Resolve Exception’ button.  If you know that the only remaining 

exceptions are students which you deemed should not be loaded to the roster (i.e. like a child is who is not 

age eligible for Pre-K), then click on the orange ‘Cancel’ button to dismiss the popup and continue with 

adding the additional student manually. 

 

Q.  I have completed my updates and I am on the site list screen. I don’t see a submit button.  Where 

is the submit button? 

A. Only one person will see the submit button and that is the person with the Provider Management role. 

 

 You are trying to submit a roster before the count date. 

 You are trying to submit a roster that does not have a ROSTER UPDATES COMPLETE status.  

 

To obtain the correct roster status, complete the following steps: 

Step Action Required 

(1)  On the Provider Site List window, click the hyperlinked Site Name you want to correct. The Class 

List window displays. 

(2)  Click the hyperlinked Class ID you want to update. The Class Roster page displays.   

Note:  Each class must be updated to Roster Updates Complete separately. 

(3)  
The  button located in the upper right corner on the Roster Details page. Once 

you locate the button, click it to update the status to Roster Updates Complete. 

(a) If there are errors, a message will appear in red at the top of the page. You will have to fix the 

errors and then click the Roster Updates Complete button again.  

(b) If there are no errors, click the Return to Class List button at the top of the page. Once you 

are on the class list, you will click the Return to Site List button at the top of the page. 

(4)  Once you are on the Site List page and you have a status of Roster Updates Complete, begin the 

submit process by reading the certifications and following the instructions provided on each screen. 

You will not see the submit button until you have accepted the certifications. 

 

 

 

By submitting a roster(s), you are asserting via electronic signature that the information on the roster(s) is true, 

complete, accurate, and includes all available student and teacher information.  

 

 

 

If you are the Provider Manager and don’t see the submit button, then… 

Important 


